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Contact Us

Sysgem Software Distribution & Support
If you need information or assistance with SysMan, please get in touch with your
supplier in the first instance.

If you need to contact 'Sysgem Distribution' for:


Sales Support



Information on software updates and release notes



Frequently Asked Questions

... please visit:
www.sysgem.eu
… or send email to:
sales@sysgem.eu

If you need assistance with SysMan for:


Technical Support

... please visit:
http://www.sysgem.eu/knowledgebase
… or send email to:
support@sysgem.eu
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Introduction

What’s Inside
This is the guide to using SysMan Utilities from Sysgem AG.
For further information see also:


SysMan Remote Control User Guide



SysMan Utilities On-Line Reference



SysMan Utilities Professional Edition: Installation and Configuration
Guide

Product Range
There are the following editions of SysMan Utilities:
1. SysMan Remote Control: is a stand alone console for accessing the desktops of
remote Windows systems. It is typically installed on administrator workstations
and is licensed per administrator.
2. SysMan Utilities Standard Edition: is a stand alone console for managing
remote Windows systems. It is typically installed on administrator workstations
and is licensed per administrator. It includes SysMan Utilities and SysMan Remote
Control to remotely manage and access PCs and Windows Servers.
3. SysMan Utilities Professional Edition: includes the same SysMan Utilities and
SysMan Remote Control but also has:


Multiple SysMan user accounts that are managed centrally.
Individual SysMan accounts are separately allocated to Windows
administrators and each can be assigned different access permissions. The
product, thereby, is able to be used to delegate distinct management
responsibilities to different administrators.



A central Audit Trail that keeps records of the activities of all
management actions undertaken by the product.
It records:
- the identity of the remote machines on which the action was taken
- the identity of the administrator
- the date and time
- the details of the transaction

SysMan Utilities Professional Edition is typically installed on a Windows Server
for its central management and control and the console component (only) is
typically installed on administrators’ workstations.

For further information on SysMan Utilities, please contact:
sales@sysgem.eu
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SysMan Architectural Concept

Components
SysMan Utilities Professional Edition is comprised of the following components:
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SysMan Authorization Server: - is typically installed on a central Windows Server
and is used to hold the identity and permissions of SysMan users. It is also the
place where the Audit Trail is recorded.
SysMan Management Console: - is typically installed on administrators’
workstations and provides the user interface for the two sub-components: ‘SysMan
Utilities’ and ‘Sysgem Remote Control’.
SysMan Utilities: - has a number of system management tools for managing
remote Windows systems. The tools run inside display windows that can be
connected simultaneously to multiple remote machines.
SysMan Remote Control: - is used to access remote Windows desktops and take
control over the logged in Windows sessions. SysMan Remote Control can be
connected to multiple remote desktops, each connection being in a separate display
window.
SysMan Remote Control Server: - is installed on a remote desktop machine when
SysMan Remote Control first connects to that machine.
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Using SysMan

Getting Started
Starting the SysMan Management Console (GUI)
Start the SysMan Management Console using the Windows "Program Start" menu
or by using the shortcut placed on your Windows desktop.

Logging In

SysMan Professional has been preset with two accounts:


”System” (a system privileged account)



“SysMan” (a normal privileged account)

The preset password for both these accounts is :


sysgem

(Passwords are case-sensitive. Here, the password is all in lower case)
Press “Select” in the “Authorization Server” box of the login screen to enter the
name (or IP address) of the machine running the SysMan Authorization Server.
The port number should be entered as “7240”.
If the GUI is running on the same machine as the SysMan Authorization Server,
then “Localhost” should be entered into Authorization Server field.
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SysMan Desktop
Having logged into SysMan you will be presented with the following SysMan
desktop:

1. Title Bar
The name of the logged-in SysMan user is shown in the title bar across the top of
the SysMan desktop screen.
2. Bookmarks Pane
Use the “Bookmarks Pane” for:


Starting explorer windows for monitoring and managing remote systems



Starting the explorer windows to launch SysMan Remote Control on
remote systems



Launching the Audit Browser



Starting the Preferences Settings window



Starting the ‘SysMan About’ window



Saving and restarting SysMan Sessions

3. Main Menu Options
All options in SysMan are available from the main SysMan menu bar. The options
may change depending on whether any SysMan display windows are active and
selected. Some menu options may not be available if you do not have sufficient
privileges set in your SysMan user profile.

4. Main Toolbar
The main SysMan toolbar provides shortcuts to the commonly used menu options.
The toolbar may be removed by de-selecting the main menu option “View” >
“Main”.
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5. Display Options Toolbar
The Display Options toolbar provides additional features that can be useful for
working with the data displayed in a display window. The toolbar may be
removed by de-selecting the main menu option “View” > “Display”.
6. Status Bar
The status bar appears at the very bottom of the SysMan desktop. Its main use is to
show the progress of transactions with remote systems. On the right of the status
bar are a number of icons that illuminate when there is communication activity.
Starting with the right-most icon, their purposes are to indicate that:


Information is being received from the Authorization Server



Information is being transmitted to the Authorization Server



Communication with the the Authorization Server is encrypted



Network data is compressed



Information is being written to the Archive database



A message is being written to the logfile



A script is running in the GUI

It is also possible to get a description of each icon by displaying a tool-tip for each.
Move the mouse pointer over the icon and a tool-tip description will be displayed.
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SysMan Utilities
Overview
The start point for using SysMan Utilities is the “SysMan Explorer” option that
can be found under the Bookmarks selection pane. Selecting this option opens a
window, as follows, that you can use to explore the computer network. The
network tree is shown in the left portion of the Explorer display window.

SysMan Explorer
Use the ‘SysMan Explorer’ window to browse for the computer that you want to
manage (or use the “Search for Computer” menu option to find the computer).
Select the required computer in the left pane and then select the required tool in the
right pane.
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n order to open a tool and run procedures on a remote computer you need to have
the appropriate access credentials to that computer. For information about remote
access credentials see the SysMan Utilities User Guide that can be found by
selecting the help menu option at the top of the SysMan desktop window.

Selecting Multiple Computers
If you need to start a tool on more than one computer, then instead of selecting a
single computer in the left pane of the Explorer window, select the 'container' in
which the computers reside in the left pane. A 'container' could be, for example,
the "Computers" container in Active Directory, or an Organizational Unit, or
simply the "Windows Network", or one of your own 'Label' names.
After selecting a container in the left pane of the Explorer window, you will see a
list of computers that are held in that container appearing in the right pane. Select
multiple computers in the right pane and then select the menu option: "Multiple
Computer Select" by using the right mouse key.

In the example above the ‘Computers’ container from Active Directory has been
selected and in the right pane three of those computers have also been selected.
After selecting the menu option: “Multiple Computer Select” a new window will
appear showing the list of tools that may now be used with the multiple selected
computers.
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The screenshot below shows the list of tools that are available with the three
selected machines from the previous screenshot.

Any of the tools that are invoked from this window will produce a single tool
window on the right hand side of the screen with the information from all selected
computers in that one window.
This makes it very easy to work with several computers at once.
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Help on SysMan Utilities Features:
For details on all the SysMan features and tool menu options, please refer to the
“SysMan Utilities On-line Reference” found under “Help” on the SysMan Utilities
desktop:

… or by using the help button on individual display windows and input forms for
information specific to the context of those windows or input forms.
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SysMan Remote Control
Overview
Select a computer in the ‘SysMan Explorer’ display window and then select the
‘SysMan RC’ option to start a remote session in a separate window.
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Help on Remote Control Features
For full information on using SysMan Remote Control, please refer to the SysMan
Remote Control User Guide.
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Saved Sessions
Saving and Restoring SysMan Sessions
You may often find that you need, repeatedly, to use combinations of SysMan
tools with the same combinations of remote computers. It is then useful to be able
to save the windows that are already open and connected to a particular set of
computers and then, later, be able to restart the same windows against the same
computers. This makes use of the SysMan feature known as “Saved Sessions”.
To save SysMan windows that are currently open, either click on the main menu
option “File” > “Save Session”, or:
1.
2.
3.
4.
5.
6.

Select the “Sessions” tab in the Bookmarks pane
Expand the folder “Own Library”
Double click on “Edit”
Click on “New”
Give the set of saved windows a name
Click on “Save” – a new saved session icon will appear below the “Own
Library” folder.

To restore a saved session – simply double click on the Session icon under your
“Own Library”. This will close any windows that are currently open and re-open
the windows that were previously saved. As the windows open they will reestablish the connection to the appropriate computers and refresh the displayed
data.
If you do not want to close all the windows before restarting a session, then press
the shift key while you click on the session icon and the saved displays will open
in addition to the ones already open.
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Filters
Standard SysMan Filters
SysMan is provided with a number of pre-defined filters that can be applied to all
the Tools displays. Right click in a display window and select the “Filters” option
– or click on the filter icon in the bottom bar of a display window to bring up the
list of filters in the filters selection pane.
The example below is of the Services display window. The “Filters” option has
been selected and the tab “SysMan Sysgem Utilities” has been selected to show
the standard filters shipped with the product for this particular display.

In the example, there are 199 services being displayed in the window (see the
entry “Ln 199” in the bottom right corner of the screen indicating that 199 lines of
information are being shown in the window).
If you wanted to see how many of those services were in a stopped state, but at the
same time had been set to automatically start when the system booted, then select
the filter:
“Services – Start-mode: Auto (but in a stopped state)”
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Selecting this filter causes the display window to change so that all other
categories of services are temporarily hidden:

Now only seven lines of services are shown and an examination of the “State” and
“Start Mode” columns shows that these are the services that are stopped, but have
a Start Mode of “Auto”.
To remove this temporary filter click “Remove” in the filters selection pane and
the original 199 services are again re-displayed.
Incidentally, this particular display window has an automatic refresh every 5
minutes (see the field next to the “Ln 7” field that shows “Int: 300s” - i.e. refresh
every 300 secs), so whether filters have been applied or not, the information will
still be updated every 5 minutes.
To view how the filters have been defined, use the “Edit” option on the filters
selection pane – but take care not to modify these filters. If you do, the
modification will be visible to other users and risks being overwritten when a new
version of SysMan is installed on your system.
If you do want to modify a filter, first select the Own tab on the Filters pane and
copy a filter into your own library (see the next section for details). Any
modifications you make to your ‘Own’ copy will be retained after the software has
been updated.
Saving the window (with a filter set) in a ‘saved session’ will keep the filter set on
the window for when the Session is restarted.
Please note that the Filter selection pane is a fully modal window and needs to be
closed before any other window is selected.

SysMan Utilities User Guide

Using SysMan  18

Defining Your Own Filters
You can create your own filter from scratch or you can start with a filter taken as a
copy from a standard SysMan filter.
To copy a standard filter:
1.

First open any Tools display from “SysMan Explorer”

2.

On the tool display window use the right mouse key to select the “Filter”
option to open the Filter selection pane

3.

Select the “Own” tab on the Filter selection pane

4.

Press “Edit” to edit your own filter library

5.

Then use the option:
“Import” > “From User or Library” (& select: “Sysgem SysMan
Utilities”)
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6.

You can then choose any of the standard filters to copy into your own
library for modification.

7.

Please note that filters are normally restricted so that they apply only to
nominated display types. When in the context of a particular display, the
filters for that display type (only) are displayed for selection. The displays
to which filters can be applied are defined on the “Displays” tab when
editing a filter.

8.

The “Criteria” tab (shown when editing a filter) holds the details of how
data in the display window will be used in applying the filter.
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Alarms
Alarms are shipped with SysMan Professional Edition as a ‘taster’ to give an
indication of how they can be (more practically) used in the SysMan Enterprise
Edition.
Monitoring displays in the SysMan Enterprise Edition can be run in background
mode, 24/7, without there being anyone currently logged into SysMan, which
means it is a much more practical proposition to monitor with the SysMan
Enterprise Edition than with the SysMan Professional Edition.
An example alarm is shipped with the “Volumes” tool in the Professional Edition
to demonstrate the capability. Copy this alarm into your “Own” Alarms library
using the following procedure:
1.

First open the “Volumes” tool from “SysMan Explorer”

2.

On the tool display window use the right mouse key to select the
“Alarms” option to open the Alarms selection pane

3.

Select the “Own” tab on the Alarms selection pane

4.

Press “Edit” to edit your own Alarm library

5.

Then use the option:
“Import” > “From User or Library” (& select: “Sysgem SysMan
U
t
i
l
i
t
i
e
s
”
)

6.
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Then select the “Volumes – C Drive less than 10% Free Space” Alarm to
copy into your own library for modification
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Applying an Alarm on a Display
On the “Volumes” tool display select the “Alarms” option (either via the right
mouse option or the Alarm icon in the bottom margin of the display) and double
click on the “Volumes – C Drive less than 10% Free Space” Alarm. If the C: drive
has less than 10% free space, then the alarm will immediately trigger and the alarm
banner will be displayed at the bottom of the screen:

If the C: drive has more than 10% free space, then the alarm (even though it is
applied to the window) will not trigger.
Modify the Alarm so that it will definitely trigger, either by changing the 10%
threshold or by changing the drive letter on which monitoring is taking place. Do
this by using the “Edit” option on the Alarms selection pane. Remember that you
should only modify Alarms that are in your “Own” library, or other people will
see the changes you have made and in any case an upgrade of the SysMan
software will overwrite any changes you make.

Cancelling an Alarm
As with the Filter Selection pane, the Alarm selection pane is a fully modal
window and needs to be closed before any other window is selected, so close the
Alarm selection pane.
Double click on the scrolling alarm banner at the bottom of the window and select
the ‘Cancel’ or ‘Cancel All’ option in the pop-up Alarm status window.
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Removing an Alarm from a Tool Display Window
When an Alarm has been set on a window, the Alarm icon in the bottom margin of
the window will be illuminated. Click on this icon to reveal the Alarm selection
pane, and then click “Remove” to remove the Alarm from the window.
Note that closing a Tool display window and re-opening it again will also remove
the alarm from the window.
Saving the window (with an alarm set) in a ‘saved session’ will keep the alarm set
on the window for when the Session is restarted.

Alarms in SysMan Enterprise Edition
Alarms in the SysMan Enterprise Edition are used in conjunction with displays to
detect potential errors and attempt to correct them and / or inform others of the
error condition.
Typical errors are:


Loss of network connection



Disk errors



Disk full



Printer off-line



Break-in attempts



Machines and processes not available

Alarm definitions can interface to log files, SMS, pagers, help desk packages, etc.
and/or run scripts to take corrective actions, as required.
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Access Permissions to Remote Systems
Accessing Remote Systems
Before SysMan can be connected to a remote machine, it has to have the
appropriate access permissions by one of two means:


The Windows user account of the SysMan user has the appropriate
default access rights through Windows permissions



A username and password for a Windows account that does have the
appropriate access rights is known by the SysMan user

This access information is normally permanently held by SysMan for each remote
machine to be visited. Access permissions can be changed at any time using the
‘Connection Preferences’ option under SysMan ‘Preference Settings’.
When connecting ‘Remote Control’ to a remote machine there are two additional
and alternative access methods that may be set using ‘Connection Preferences’:
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By knowing a SysMan password that has been applied to the Remote
Control Server



By always being prompted afresh for a username and password each time
a connection is initiated
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Connection Preferences
The following shows the ‘Connection Preferences’ Option from ‘Preference
Settings’:

Further help is available by selecting the help icons on the ‘Connection
Preferences’ display window and the ‘Credentials’ input form.
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Troubleshooting

Knowledge Base Pages on the Sysgem Web Site
Please consult the Knowledge Base Pages on the Sysgem web site for any
difficulties that you may encounter when using this guide.

http://www.sysgem.eu/knowledgebase.

If that fails to resolve the issue, please email the support team at the following
email address:

support@sysgem.eu
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